Design History of HCPM

July 1997:  Public workshops given describing model logic

October 31, 1997:  Version 1.0

- Fully operational but preliminary versions of Cenblock.exe and Feeddist.exe

- data for 6 wirecenters

December 17, 1997:  Version 2.0

- input files for 49 states and DC

- multiple SAIs allowed in each grid

- spanning tree algorithm for feeder network implemented

February 5, 1998:  Version 2.5

- spanning tree algorithm extended to distribution network

- revised input data for 49 states and DC released

July 20, 1998:  Version 2.6

- Cluster algorithm implemented

- Cluster interface creates microgrid overlay for clusters

September 24, 1998:  Modifications to Version 2.6

- Visual Basic interface released

- Run-time enhancements, such as binary table lookups

- Minor bug corrections, such as incorrect cable sizing and terrain adjustment

- Reporting of structure route distances

- Ability to handle non-integer number of lines

- Improved data error-checking

November 18, 1998:  Modifications to Version 2.6

- distance computations in cluster algorithm corrected

- Visual Basic code in cluster algorithm broken up into multiple procedures

- Clusintf modified to correct a minor data leak and to enable passing CBG identifiers

- Clusintf and Feeddist modified to assume that each line in a .in file represents either one household or one business location, removing data ambiguity.  Feeddist variables TakeRate, lines_per_household, lines_per_business no longer read from .txt files, but rather calculated within Clusintf.

December 7, 1998:  Modifications to Version 2.6

1. Modifications to User Interface

- Modified the interface to allow the full set of options for both CLUSINTF and FEEDDIST

to be entered as a user input.

- Modified PKZIP(UNZIP) to correct a window closing problem.

2. Modifications to Cluster.exe

- Modified the CLUSTER module and the HCPM inputs sheets to allow the user to modify all of the user adjustable clustering parameters for use in doing batch runs of the model.

- Modified the agglomerative and nearest neighbor clustering algorithms so that they determine

cluster size after taking account of the line limit fill factor just as the divisive algorithm does. 

(It is, nevertheless, recommended that users choose a line fill factor equal to 1 when these algorithms are run.)

- Modified the full optimization routine so that it stops based on a maximum number of passes instead of a maximum optimization time.

- Modified the maximum pop cells constraint in the divisive algorithm to equal 3 times the user

input value (by default equal to 1000) instead of a hard coded value of 3000.  The effect of this

change is to allow the user to override the feature of the algorithm which progressively increases

the raster size whenever the actual number of pop cells exceeds the maximum.

- Added a "use terrain.mdb" check box to allow the user to choose whether to get terrain data

from a db or from the input files.

3. Modifications to Clusintf.exe and Feeddist.exe

-The quadrant assignment formula in CLUSINTF has been corrected.  This change will have no effect on costs, since quadrant information is never used.

- Soil slope factor not applied properly.  We have adopted the BCPM suggested changes to our code.  (Module STRUCTUR.PAS)

- Water table depth adjustment has been implemented per BCPM suggested code.  (Module STRUCTUR.PAS)

- Determination of hardrock, softrock, and normal structure has been corrected per BCPM suggestion with one change (there appears to be a problem with the translation of the EXCEL logic).  (Module STRUCTUR.PAS)

- Manhole costs for softrock and normal have been set properly.  (Module STRUCTUR.PAS)

- If structure percentages sum to a value greater than unity, the program now stops execution  (previously it did nothing).  We like the suggestions filed with this item, but at this time we are not implementing them due to time constraints.   (Module STRUCTUR.PAS)

- Fibers on a small DLC system are not shared with other systems on the same route.  The source code cited for this problem comes from the module PRINTOUT.PAS, in which a function call is made for purposes of reporting compatibility only.  In "actual" network construction, fiber structure is shared with other nodes on the same route, so nothing was done here.

- Created a new allocation weight for feeder components rather than simply number of lines.  We note that the right way to do the cost allocation would be some variant of the Shapley value, but we do not wish to change the model logic at this time to this degree of complexity.  The new allocation weight for each cluster is now
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where

DistToSwitchi = route distance from central office for SAI node I

Linesi = number of lines in serving area i.

This formula gives both lines and route distance from the central office a role in the weighting scheme. (Module PRINTOUT.PAS)

- Installed logic to count up single line business locations as follows.  We count the number of locations in the .IN file with 0 to 1 lines, n1, and the number of locations with 1 to 2 lines, n2.  For each location i,  let

pi = the number of lines, if location i has  between 0 and 1 lines

        0, otherwise

qi = the number of lines, if location i has  between 1 and 2 lines

        0, otherwise

sl1 = expected number of locations with one line from n1 locations

sl2 = expected number of locations with one line from n2 locations

slb = expected number of single line business locations
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  (Modules CLUSINTF.PAS, GLOBALS.PAS, DISTRIB.PAS, PRINTOUT.PAS).

- Added logic so that SAI investments are always included at an SAI location, independent of the technology chosen.  (Module TECH.PAS)

- Made no changes to the NID and drop calculations in DISTRIB.PAS pending resolution of customer location data issues.

December 15, 1998

- Full interface including HAI components released in a self installing setup file.

- A new procedure has been added to Clusintf to true-up line counts so that at the wire center level residential lines are never less than residential locations, and business lines are never less than business locations. If number of lines is less than number of locations; a true-up factor equal to the number of locations (bus or res) divided by the number of lines (bus or res) is applied to the lines at each customer location in the wire center. If the number of lines exceeds the number of locations in the wire center, no true-up is done.

January 5, 1999

- In the December 15, 1998 release on the FCC web site, the file “install.zip” failed to include a data directory. The installation package assumes that a directory called “data” is located in the “hcpm” directory along with other directories such as “armis”, “db” and “documentation.”  It is the responsibility of the user to create this directory and to separately obtain customer location data files and place them in it.  If desired, the data directory can be given any name and placed in other locations as long as the initialization file “hcpm.ini” is appropriately edited.

- Interface modified to delete an error checking routine that in some situations may falsely report that the file “multinec.lst” is not present, when in fact it is.

- Cluster.exe modified to correct a problem which caused the program to hang up when presented with input data in which both business and residential line counts are equal to zero at a customer location.

- Feeddist.exe modified to correct an error in which the sum of distribution or feeder mix factors occasionally summed to slightly greater than 1 due to a machine precision error, even when the values in the input tables appear to sum to 1.

January 19, 1999

- Some versions of Microsoft Office 97 may not be compatible with some of the system calls made during operation of the synthesis model. The current release contains two Microsoft utilities that can be used to determine whether a problem exists and to modify the version of Office 97 if necessary. First run the program “PatchChk.exe” to determine if Microsoft Service Release 1 is present in your version of Office. If it is not, then the program “SR1Off97.exe” should be run to install the service release.

- Some new users have experienced difficulties in running the synthesis model interface for the first time. Based on their experiences, all new users should note the following: (1) When installing the interface using the downloaded file “install.zip” obtained from the FCC web site, be sure to decompress this file using Winzip, Pkzip for Windows or similar software which is capable of maintaining long file names. Do not under any circumstances use the DOS version of Pkzip for this purpose. (2) A data directory must be created and all input files placed in it should remain in compressed form (like the file Md.zip which is distributed on the FCC web site); (3) The default option for the interface is to begin operation with Feeddist.exe. The first time that any state and company is run, however, the programs must be run beginning with the Cluster program; (4) The root directory name where the HCPM files are placed should not contain any interior spaces. Similarly, the data directory should not contain interior spaces or exceed eight characters in length. Warning messages in the interface program now alert users to these potential problems. (5) First time users do not generally need to edit the options in the interface window in the textboxes labeled “clusintf options” and “feeddist options.” By changing “Feeddist options” the user can change the degree of optimization in distribution plant (by changing the number following –p). The –v option, however, should not be deleted by the user since this option instructs the program to write the .csv files that are required by the interface. A full explanation of these options and those for the cluster interface program are contained in the document “hcpm.doc.” (6) The block divide user input parameter to the Cluster program does not have any effect on the program when geocoded input data is used. This input is relevant only when Census block level data is used; (7) Once the setup is complete and the interface program has been started by running the program “hcpm.exe” the following steps should be followed: Choose “Edit HM Scenario”, then go to the “HM Tools” menu and select state and company. Choose a state or the multicompany option and then a company or set of companies. A default scenario will then be created. Close the HM Model window and then choose the “Select state and company” button. Repeat the selection of state and company and double click on the default scenario choice when the scenario window appears. Next select an HCPM input set from the Inputs subdirectory. You are now ready to run the model by clicking either the “Run HCPM modules in batch mode” button or the “Run HCPM and HAI 5.0” button, assuming that input data is present for your selection of state and company; (8) There is an error in the file “setup.lst” that was supplied as part of the installation package released on December 15, 1998. The portion of the file that contains the text “File23=1,,VBDB32.DLL,VBEB32.DLL” should have contained the text “File23=1,,VBDB32.DLL,VBDB32.DLL”. The impact of this error is that users who have not previously installed the HAI model may not have a needed system file that the model requires. Users who experience difficulties in running the HAI portions of the interface should reinstall after editing the file setup.lst appropriately. The current version of the file “install.zip” corrects this problem.

- The format of input files has changed slightly from previous versions of the model, and users must now either reformat or delete all previous versions of the HCPM input files in Excel spreadsheet format. Sample inputs with the new format are contained in the file “NewInputs.xls” which is distributed with this release.  The current version of the program supports header lines in all data files if the header line begins with a "*".  In addition, all variables in the input files that are not currently being used by the program have been deleted. Among the variables deleted are those indicating the maximum cable capacities for the various technologies; these capacities are now calculated directly from the cable tables. The current version supports separate input files for 26 gauge distribution copper cable, 26 gauge feeder copper cable, 24 gauge distribution cable, 24 gauge feeder cable, and t-1 feeder cable, rather than relying on the use of multipliers. It also supports a fifth DLC size in addition to those already supported.  DLC capacities currently supported are now 2016, 1344, 672, 96, and 24 line facilities. A separate site preparation cost for DLCs is now applied to all large (2016, 1344, and 672 lines) DLCs but only to small DLCs (96 and 24 lines) if more than two units are deployed.

- The cluster algorithm now performs a true-up of residential and business lines at the wire center level. In addition, the clustering algorithm now takes account of special access lines and public telephone lines in determining cluster size. The true-up will make it easier to compare alternative sources of customer location data, and it will also allow alternative sources of wire center level line count data to be used at the user’s option. Both line count data and terrain data at the CBG level are now contained in a database called “hcpm.mdb” which must be present in the db directory. This database replaces the database called “terrain.mdb” which was used in earlier versions of the model.

- The model now assumes that the Special Access Ratio for business lines has been calculated for the wire center and is recorded in a file called <areaname>.LIN. This file is created by the Cluster module which accesses a database with line count information as explained above.  If this file does not exist, the program will look up the special access ratio for the entire state in the file STATES.TXT. (Note: Since the .lin file is produced by the cluster module all study areas must be recomputed beginning with the cluster program in order for this modification to become effective.)

- The terminal choice optimization algorithm has been modified. In the current version, the model first calculates the cost of using each technology for a given serving area.  Next, it checks the engineering constraints.  If the serving area violates the constraints for a particular technology, the cost for that technology is reset to machine infinity. The minimal cost technology is then chosen. Previously it was implicitly assumed that analog would always be cheaper than T1/HDSL and that T1/HDSL would always be cheaper than fiber.

- T1 terminal costs are no longer computed for special access lines provided at DS1 grade.

- The current version of Feeddist corrects a minor algebraic error in the fiber and t1 terminal calculations that had been resulting in the model reporting an improbably large number of small DLCs as the optimal choice for serving certain clusters.

- The current version of Feeddist corrects two reporting errors in the worksheet “Feedbywc.csv” in which single-line businesses and total special access lines for the wire center were reported improperly.

February 2, 1999

- Tip for new users: Do not attempt to run the interface or any of the program modules from the “bin” directory. This directory is intended to hold backup copies of the executable files. The interface should always be started from the main HCPM directory.

- In one case a user experienced difficulties in running the synthesis model that were resolved when a version of the HAI model on the same machine was removed. Generally, it is possible to maintain copies of both models on the same computer.

- Modified versions of the HAI switching and expense modules are provided with this release.

- Cluster module modified to correct a problem that existed in the line count true-up procedure when the database requires a true-up to a zero line count. In this case either residential or business locations could be assigned a zero line count which would lead to incorrect clustering results.

- Technical fix to the cluster module: a file was not properly closed, which caused the program to occasionally terminate unexpectedly.

- Technical fix to the interface program: when outputs of the cluster module were saved to the file “cluster.zip,” the line count files (*.lin) were not previously included. As a result, users attempting to begin operation with the cluster interface module would not have access to these files.

- The input file “states.txt” and the corresponding worksheet in the file “newinputs.xls” has been modified to delete all data columns except the data for the special access ratio. Users who do not substitute the file “newinputs.xls” from the current release should manually delete the columns for Take Rate, Lines/HH, SLBus, MLBus, and Public.

February 16, 1999

- The size of the hcpm.mdb database can be significantly reduced by compacting it. This will also result in improved run time performance for the cluster module. Users should open the database using Microsoft Access, then select the Database Utilities option in the Tools menu.

- The output file “feedbywc” has been modified by adding six additional columns which are designed to represent structure sharing fractions. This change is designed to ensure compatibility with future modifications of the HAI expense module. This modification will have no effect on any of the cost computations in the current version of the  model

- Interface modified to correctly save input files from the NewInputs.xls spreadsheet (or any other input sheet) with the correct file type (*.txt or *.prm) even if the order of the relevant worksheets is altered by the user.

- Interface modified to accept input data on both distribution and feeder plant mix at the study area level. These data are created by comparing model generated route lengths with Armis data. Computations are done in a macro contained in the file PlantMixTemplate.xls.

March 2, 1999

-The process by which HCPM inputs are transferred from the Excel spreadsheet to the text files used by the model has been modified. This is now done using a macro “ParamSave” which is contained in the newly released file “Hcpm_Inputs.xls”. (Pervious releases contained preliminary versions of the same macro but these do not function in exactly the same way as the current macro. As a result all previous inputs sheets must be converted to the new format either by copying the data to the appropriate sheets in the new file or copying the macros contained in the new file to the old input sheets.) The interface also calls the macro ParamSave instead of relying on internal code to handle these input files.

- Cluster.exe modified to correct a line count reporting problem in which lines for each cluster incorrectly included special access and public lines. (This modification was included in the last update cycle but this notice was omitted.)

- Interface modified to remove a warning message which appeared if the file “PlantMixByStudyArea.csv” is not present. If this file is not present the default national input values for distribution and feeder plant mix are used and no warning message appears. The file PlantMixByStudyArea.csv has also been slightly modified to eliminate a few situations in which negative plant mix percentages were reported.

- The files hcpm.mdb, hm50.mdb and all of the files in the distance subdirectory have been modified so as to replace all spaces in the names of CLLI codes with “_” characters. This convention conforms to the current customer location fine naming convention used by PNR.

- The cluster module has been modified to replace all spaces in a wirecenter name with a “_” character.

- The file setup132.exe has been modified to create an initialization file that directs the HAI portions of the model to use the new switching/transport and expense modules. The version released in the last update did not work correctly with Windows 95.

- The Feeddist module Structure has been modified so that the program terminates only if the plant mix percentages sum to more than 1.0001. Previously the cutoff value had been 1.00000001 which led to occasional error messages if input values were computed with single precision accuracy.

- The output file Feedgrid.csv now reports total distribution route distance and allocated feeder route distance instead of distribution line feed and feeder line feed, respectively.  The allocation scheme used is the same as that used for other feeder allocations: the weight for each cluster is the number of lines for that cluster times the distance of the cluster’s SAI from the switch. ; The change in Feedgrid.csv affects columns AQ and AR in the Feeder Output by Cluster worksheet in the HAI work file.

April 6, 1999

- Cluster.exe has been modified to extend the business line “true-up” procedure to include single line business lines as reported in the hcpm.mdb database. The modification works by comparing the number of business locations and the number of SLB lines, then sorting the line counts by business location and resetting the business lines for the #SLB locations having the smallest line count to 1 and then doing a true-up for the remaining locations to make total business lines equal to the number reported in the database.

- Some of the modules now write error messages as text files in order to report potential problems or inconsistencies with either the customer location data input files or the hcpm.mdb database. The following files are writen as needed:

CLLICODE.cbg indicates that cluster.exe has encountered a missing CBG from the terrain table of hcpm.mdb.

CLLICODE.dat indicates indicates that cluster.exe has encountered a missing wirecenter name from the lines table of hcpm.mdb.

CLLICODE.err indicates that clusintf.exe has encountered a missing or corrupted .in or .clu file.

CLLICODE.ter indicates that clusintf.exe has encountered missing or unusable terrain data.

CLLICODE.tru indicates that the line count true-up ratios computed in cluster.exe appear to be outside of reasonable bounds. This condition may indicate an inconsistency between the CLLICODE.in file and the hcpm.mdb database.

- The modification to the interface under the third paragraph of the previous update bulletin was inadvertently not included in the release. The current release corrects this.

- The optional arguments to clusintf and feeddist are now set in the input file “HCPM_Inputs.xls” instead of through a text window in the interface program. The default setting for distribution optimization has been set at “-p500. This will cause slower run times for the feeddist module, and users desiring a quick turnaround (but less accurate results) may wish to set this input at “-p0”. There is also a user adjustable input to determine whether or not to use the PlantMixByStudyArea.csv file. The current default setting is to not use this file.

- The cluster algorithm has been modified to create an initial cluster with fixed center at the switch location. All customer locations within the distance limit of the switch are initially assigned to this cluster, and each of the algorithms (divisive, agglomerative and nearest neighbor) then proceeds. During the simple reassignment phase of the algorithm some locations may be reassigned from the initial cluster location.

- The recommended distance limit for the cluster algorithm is now 17,000 feet, assuming that a distance limit of 18,000 feet is used in the remaining modules.Since the grid overlay procedure in the cluster interface module can potentially increase the distance of some customers from the cluster center, some clusters that might fall entirely within the distance limit, and therefore be served by analog plant, were being needlessly served by DLC technology.

- Minor technical fixes were made to the interface to deal with file handling.

- The default values for the annual charge factors in HCPM_Inputs.xls are now taken from an HAI expense worksheet.

- New HAI modules are included with this release.  If you do not run the installation program, then you must select these modules in the Options menu under HM_Tools.

- Clusintf.exe modified to terminate computations for any wire center with more than 8000 point locations in a single cluster. This condition could occur if the line true-up procedure reduced the line count at each location drastically.

- Feeddist.exe modified to slightly alter the reporting conventions in distgrid.csv, feedgrid.csv and feedbywc.csv.

April 20, 1999

- The Cluster module has been slightly modified so that the initial cluster created near the wire center, and any subsequent clusters created by breaking this cluster up due to line limit constraints, now have their centroids located at a point in the rectangular hull of the cluster points that is closest to the switch location. Previously the centroid was located at or near the wire center, and this led to difficulties in some situations in which the wire center was located more than the distance limit from every point in the cluster.

- New HAI modules are included with this release.  If you do not run the installation program, then you must select these modules in the Options menu under HM_Tools.

- The Prim algorithm implementation has been modified to optimize using a provisional cost function defined on the basis of average cost per line rather than total cost.

- Following comments from GTE and others, the calculation of feeder/distribution interface costs has been corrected to reflect the sum of feeder and distribution lines, and corrected investment costs are reported out.

- Following GTE comments, calculated feeder fills have been corrected.

- Following AT&T's observation that structure mix optimization appeared not to function properly, we have corrected the structure optimization routine such that residual structure type percentage minimizes the sum of annualized structure costs plus annualized cable costs.

- The calculation of cable costs has been simplified to make the programming easier to understand.

- The module Printout.pas has been corrected to handle situations where feeder is allocated to only one cluster.

May 18, 1999

- The cluster module was modified to correct a problem in the true-up of single line business lines which occurred when the reported number of single line business lines was less than the number of business locations in the input data file.  Now when this situation occurs, no line true-ups are attempted for that wirecenter.

- New inputs are provided in the files Hcpm_inputs_518.xls, HM50.mdb and in the new HAI modules RFCC_expense_density.xls, RFCC_expense_wirecenter.xls and RFCC_switching_io.xls. These inputs represent staff recommendations, but they have not yet been adopted by the Commission.

- The loop design module Feeddist.exe was modified to correct an error in retrieving data from the structure placement cost tables.

June 1, 1999

- Input files with this release now correspond to the inputs tentatively adopted by the Commission in a May 27, 1999 Further Notice of Proposed Rulemaking.

- Feeddist.exe has been modified so that it no longer requires the inpuf file “states.txt” to operate properly. That file was used to provide an input value for the ratio of special access lines to business lines. This information has been extracted from the database “hcpm.mdb” for each wire center beginning with the January 19, 1999 release, and the current change simply reflects this fact.

- The interface can now be fully controlled by user adjustable inputs.  The “interface” sheet of the file “hcpm_inputs_527.xls” has been correspondingly modified.

October 21, 1999


- Model databases have been updated to reflect 1998 line counts

- The recommended default raster size in the cluster module has been changed from 500 feet to 150 feet.

- The user interface has been modified to allow the selection of the “Plant mix by study area” option through a check box.

- The HCPM input table for feeddist paramters (FEEDDIST) has been modified to accommodate the design changes in Feeddist as described below. The input table for feeder/distribution interface costs (FDI) has been modified to account for the possibility that some serving areas (clusters) may have line counts larger than the cluster module line limit. The input table for drop terminal costs (DROP)has been modified to reflect the cost of an indoor SAI for line capacities greater than 25 lines. Other changes in the values of some inputs have been made since the previous release in response to comments received.

- This version corrects a minor error in the distribution module, DISTRIB.PAS, in which physical copper lines were being counted incorrectly.  In the previous version, one pair was being allocated to each DS0 channel, regardless of whether that channel was served by DS0 or DS1.  The correction allocates two pairs for every 24 DS0 channels whenever a location is served by DS1, but continues to serve DS0 locations as it always has.

- In this version of CLUSINTF, a true-up procedure suggested by AT&T in which the total number of locations (business or residential) could never exceed the number of lines has been eliminated.  Thus, the number of lines reported out of CLUSINTF is not affected.  To achieve the desired reporting effect, we have substituted a line of code that reports out a number of housing units that is the lesser of total lines and locations in each cluster (and the same for business locations).

- In this version of CLUSINTF, the procedure for counting single line business locations has been modified.  In this version, only those business locations with 1.0 or fewer lines per location are counted as single-line locations, with no allocation of locations having between 1.0 and 2.0 lines.

- We have modified the module TECH.PAS so that when feeder-distribution cross-connect boxes are sized, the sizing reflects the cable size of both the distribution side and the feeder side demand after accounting for respective fill factors.  Thus, the box size is equal to the cable size required for the D-side plus the cable size required for the F-side.

- The variable SpclAccessLines_per_bus has been deleted from the FEEDDIST.PRM file.  This variable is not used anywhere in the program. - In the interest of avoiding hardcoded numeric values, the following variables have been added to the FEEDDIST.PRM file:


ChannelsPerT1System : Channels per T1 system, Default value 24


PairsPerT1System    : Number of physical pairs per T1 system, Default value 2


FibersPerTerminal   : Default value 4


CapacityF2016       : Default value 2016


CapacityF1344       : Default value 1344


CapacityF672        : Default value 672


CapacityF96         : Default value 96


CapacityF24         : Default value 24


CapacityT96         : Default value 96


CapacityT24         : Default value 24

Note that while these changes will have no effect on calculations performed by the cost model if default values are adhered to, their inclusion as parameters adds flexibility to the model in that, for example, European E-1 technology can now be modelled (with 30 channels per system). Different fiber terminal sizes can be modelled as well.

- In previous versions of the program, the file FEEDGRID.CSV reported an allocation of feeder plant between fiber and copper that was hardcoded to 50%.  This allocation has been changed to

Pct_fiber = (wirecenter DS0 lines served on DLC) / ( total wirecenter DS0 lines)

The allocation of feeder plant to individual clusters remains the same, and we have not changed the hardcoded allocation of 10% of underground structure cost to conduit.

- Clusintf.exe and Feeddist.exe have been modified to correct two errors in reading terrain data. In previous versions of clusintf.exe the soil type was not defined properly and its impact was not recorded, with the result that terrain conditions that should have been treated as soft rock were treated as normal rock by the model. In previous versions of feeddist.exe, the water factor was computed incorrectly by reading an input table value for copper placement depth (inches) instead of critical water depth (feet), with the result that the water table multiplier was applied incorrectly.

· In the current customer location data set for the MDSNWI16 wirecenter using 1998 line count data, the model will not run using the default input values for the cluster module since some clusters in this wirecenter have line counts that are larger (after the special access line multiplier is applied) than the largest possible integer in Pascal (and all) programming languages. Since line counts are currently modeled as integer variables rather than long integers, the module feeddist.exe fails in this situation. The large line counts in some clusters occurs because this wirecenter contains a large number of business locations with large line counts that are spaced closely together. As a result some raster cells, which cannot be broken up by the algorithm have line counts in excess of 29,000 lines. The wirecenter can be run successfully by selecting a raster size of 20 instead of 150 and increasing the maximum number of populated cells (Max pop cells) from 1000 to 30,000 or more. In this mode the cluster algorithm will run extremely slowly, but will produce outputs that can be successfully run by the remaining modules.

January 14, 2000

- The cluster module has been modified since the October 21, 1999 release by defining two variables in the Calc_init_cluster_centroid procedure as real valued variables instead of long integers. This step was necessary in order for the wirecenter SNJNPRXB to run correctly.
- 1996 line count data for the wirecenters associated with Anchorage Telephone Utilities in Alaska has been added to the LineCount table in the Hcpm.mdb database. This data was absent from the database used in the October 21, 1999 release because 1998 ARMIS data was not available for this company.

- 1998 line count data for two companies, United Telephone Co. of FL and Central Telephone Co. of FL, was incorrect in the October 21, 1999 release. The LineCount table in the Hcpm.mdb database has been corrected for the wirecenters associated with these companies.

- A programming error in a version of the synthesis model interface, hcpm.exe, caused some crucial files containing line count true-up data to be missing from the cluster.zip files created during the operation of the model. This error was corrected before the October 21, 1999 release. However, in the computations used for the October 21, 1999 release, clustering for 34 companies (NECA numbers between 205050 and 330886) was done on a computer containing the older incorrect version of hcpm.exe. 

June 13, 2001

The following changes to the HCPM portions of the synthesis model have been made subsequent to the January 20, 2000 release of the model:

Cluster module

- A procedure Subdivide_Large_Clusters has been created which is called after each operation of the Simple_ClusterReAssignment procedure. In previous versions,  this procedure was called only a single time and the code was embedded in the main routine.

- The procedure Merge_Clusters has been modified so that clusters are merged whenever the distance constraints and line limit constraints are satisfied. In previous versions, only clusters containing 20 or fewer lines were allowed to be merged.

- The method of truing up line counts has been modified so that both residential and business lines are trued up correctly in all situations in which either residential or business locations are missing in the customer location data (“.IN” files), or when the number of business locations is less than the reported number of single line business lines in the LineCount database. In previous versions, any incompatibility between customer location data and the line count database caused all true-ups to be turned off.

- All cluster centroid computations are now made using real variables instead of long integers. Previously, this change had only been applied to the Calc_init_cluster_centroid proceedure.

- Several modifications have been made to accommodate use of the cluster module in certain international applications. The reformat_input_file procedure has been modified to allow Census block level data to be entered in the same format as point (geocoded or surrogate) data. The word BLOCK on the first line a the .IN file is used to identify block level data. The file input window for running an individual wirecenter has been changed from a simple text window to a file list. Full Census block numbers are now reported for each location in the “.CLU” output files. Previously only the first 12 digits representing the CBG number were reported.

- The input for the block divide factor in the cluster algorithm has been eliminated. When Census block data is used as input, blocks are now divided automatically and both residential and business lines are randomly assigned to cells created within the block. The number of locations is determined by the user specified inputs for Lines per Business and Lines per Residence. For details of this procedure, consult the reFormat_InputFile procedure in the Cluster source code.

Feeddist module

- The worksheet for Sharing inputs in the HCPM input files contained in the current release has changed the labels for UG and Buried sharing percentages. This corrects a previous error in the Feeddist module in the way the input file was interpreted. Since default inputs for buried and underground structures have so far been identical, no changes in any model computations will result from this change.

- GLOBALS.PAS and CABLE.PAS modified to correct variable type declaration.

Delphi versions of Clusintf.exe and Feeddist.exe

-In addition to the modifications described above, the modules Clusintf.exe and Feeddist.exe have been translated in a new programming language, Delphi v. 6.0, and some additional programming modifications have been made to the Delphi version in response to user comments. The Delphi version of the forward-looking cost model is a beta version that will continue to be refined and updated as the Commission staff and interested parties work with it. Aside from programming modifications needed to port the Pascal programming language into its Delphi equivalent, two logic modifications were made in the Delphi version. A bug in the feeddist module, which caused drop terminals to be incorrectly located was corrected, and  some additional modifications were made to feeddist to accommodate international users of the model.

- The Delphi version of Feeddist module now installs repeaters in copper feeder plant. The spacing for repeaters is given by a user input specified in the Feeddist worksheet of the current input files.

- In order to use the Delphi modules with the existing synthesis model interface, the user should copy the two executable files “clusintf.exe” and “feeddist.exe” into the main hcpm directory and select the input file “hcpm_inputs_June2001.xls”. 

July 2, 2001

Cluster module

- Make plot function can now be controlled by input files.

Delphi modules

- Code in the cluster interface module which reports the number of single line business lines is corrected so as to report the same line counts as the Pascal version. 

Aug. 31, 2001

All Visual Basic modules in the HCPM portion of the synthesis model (Cluster.exe and HCPM.exe) have been recompiled in Visual Basic version 6.0. Some users may find that they now require the file MSVBVM60.DLL to be present in their system folder or the HCPM folder. This file is attached and the installation package has been updated to include it.

User Interface

- Several additional check boxes have been provided to give increased user control over the functioning of the model.

Cluster module

- Fixed problem encountered in batch file operation when a wirecenter is missing from the hcpm.mdb database.  True-up is no longer turned off for subsequent computations in the batch file.

- The optional plotting routines have been updated to provide more detailed outputs. These are visible at the conclusion of the module when the make_plot option is selected and a single wirecenter is run.

Cluster interface module

- Logic has been modified to permit clusters where the number of points is greater than 8000.  This has been accomplished by setting the dynamic array length for the points in each cluster equal to the number of points reported out by the cluster module, whether or not that number is greater than 8000.  Formerly, Cluster interface had been designed to halt if it encountered such a large number of points.

- Cluster interface has also been modified to handle the situation where the SAI location calculated by the Cluster module lies outside the area defined by the points in a given cluster, as can happen when the SAI is forced to locate at the switch for the initial cluster. This can occasionally lead to problems with the sizing of grids. The module has been modified so that the grid cells extend to cover all possible SAI locations.

Feeddist module

- Program modules Structur.pas, Tech.pas and Terminal.pas have been modified to correct inaccurate references to tables containing input prices for manholes, SAIs and drop terminals. 

- Model logic has been modified to handle a very rare situation in which the total number of lines in a serving area (or customer location) exceeds the maximum capacity of either drop terminals or cross-connect boxes.  In this event, the module now calculates the number of such terminals needed to meet the demand by finding the number of maximally-sized terminals required.  Otherwise, the model functions as before.

- An optional plotting function has been added to Feeddist. This can be viewed by choosing the run time arguments “-xv” instead of “-v” or by editing the feeddist worksheet in the hcpm input file.

December 18, 2001
New line count and wire center ownership data for 2001 were incorporated into the database hcpm.mdb following the same procedures used for the previous year’s update. In addition, the table “Lerg_Host_Remote” in the hm50.mdb database was modified so as to remove entries corresponding to wire centers no longer identified as owned by reporting large companies.

Cluster module

Corrected a “subscript out of range” error which arose after new line count data for 2002 universal service support was obtained. The new data resulted in an extreme divergence between the reported number of current residential lines and the number of residential locations contained in the customer data set for some wire centers. The correction does not change the basic logic of the cluster module.

October, 2003
Expense modules

The expense modules were modified to correct a discrepancy in the reported results in the density zone and wirecenter versions. These modifications are documented in the file “101499CH.doc”. The new modules have been renamed to highlight their creation date of October 2001. As a result of these name changes, the initialization file “hcpmhm.ini” located in a Windows directory must be changed, either by directly editing the file or by running the full HCPM installation program as issued with the most recent release.

The following steps should be taken to run the correct expense portion of the model without running the full installation program.
1. Copy the replacement file RFCC_expense_wirecenter_October2001.xls from the FCC web site.

2. Place the file in the “Module” sub-directory under the main HCPM directory.
3. Edit the file hcpmhm.ini to point to the desired expense module

(RFCC_expense_wirecenter_October1999 or RFCC_expense_wirecenter_October2001)
4. Rerun the expense portion of the model.
Cluster module
The Cluster Module creates clusters of customers to which outside plant is built.  At the end of the cluster algorithm, all final clusters are subdivided into two parts, which the Cluster interface module and Feeddist module subsequently process to see whether costs are lower.  In cases where there is only a single customer location in the original cluster, the program was unable to perform the required division, and erroneously placed the location of the SAI for the divided clusters at the central office, instead of at the centroid of the cluster.  The technical correction addressed the “divide the cluster” logic at the end of the program.  Where there is only a single customer location, the original program led to a divide by zero error.  The Visual Basic compiler caused the program to skip the lines of programming code which led to the error, and then continue.  As a result, the SAI locations for the divided clusters were given their default values (i.e. zero x and y coordinates) which happens to be the location of the switch.  The new Cluster module fixes this problem by assigning SAIs to the location of the SAI of the undivided cluster.
Cluster interface module
When the Cluster interface module was originally translated to Delphi, it was also modified to correct for the error in the Cluster module described above.  The program was altered to reduce the number of populated microgrids and make microgrids larger than the original Pascal version, thereby including more lines in each populated microgrid.  That is, the program overrode the default 360 feet by 360 feet microgrid size and instead adjusted the microgrids so that the microgrid “matrix” was always 50 x 50 = 2,500 microgrids, which would vary in size for different clusters.  Now that the Cluster module has been corrected, the Cluster interface module reverts back to the Pascal program logic, i.e., the original 360 feet x 360 feet microgrid size.
Feeddist module

When the Feeddist module was translated to Delphi, a change was made in how feeder distances are reported.  In the original Pascal version, the output by distribution cluster "allocated" the total feeder route distance to each cluster by an allocation fraction related to the number of lines and the direct distance of each cluster to the switch.  The Delphi version reports the direct distance of the cluster center to the switch.  This has no effect on investment cost calculated by the model; it is simply a reporting change.
September, 2004

Migration of the HCPM/HAI 5.0 application modules to run successfully under the Windows 2000/Microsoft Office 2002 environment. 

The existing version of HCPM/HAI 5.0 required the user to have Microsoft Access 97 installed in order to make changes to inputs.  Without Access 97 installed, the program would not run.  The following steps were taken to enable users to run the Model with Windows 2000 (or later versions), and Access 2002 (or later versions).  These steps are now embodied in the new “Install Version” of the model (to be) posted on the FCC Web site.  

Alternatively, a user who has newer versions of Microsoft Windows and Office installed could repeat the following steps and perform their own conversion.  Of course, a user can continue to use their old version of the model with the older Access 97 version, however this old version of the Model will no longer be supported by the FCC.  All future enhancements to the Model will be performed on the new migrated version.


A.  Download the Microsoft Office 2000 SR-1/Windows 2000 Registry Repair Utility:

A patch restores the registry settings for several important files that are needed to enable Office 2000 SR-1 and 2002 applications to work properly on Windows 2000. The following URL contains the download and installation instructions:

http://www.microsoft.com/downloads/details.aspx?FamilyID=3CA24EF2-72EC-4DC1-B092-DFA114329486&displaylang=EN (visited 8-1-04)

B.  Convert existing Access 97 databases to Access 2002 format:

The hcpm.mdb and hm50.mdb formatted databases were migrated from Access 97 to Access 2002 file format so that they would be compatible with MS Visual Basic 6.0/Office 2002 products.  This was accomplished by invoking the MS Access Database Conversion Tool within the Access 2002 designer program.

The following steps were performed on each database file:

a) Open the MS Access 2002 Designer.

b) From the Main Toolbar, select the following option:

Tools > Database Utilities > Convert Database > Access 2002 File Format

c) Convert the hcpm.mdb and hm50.mdb database files in the c:\HCPM\DB folder.

The above steps convert hcpm.mdb properly.  However, the hm50.mdb conversion contains errors while attempting to convert the database links to the hmxldb.xls Excel spreadsheet.  This is apparently due to a Microsoft bug in the conversion utility, since the existing links work properly under Access 97.  To correct these conversion errors, the following additional steps are performed on the hm50.mdb database:

1)    Open the converted hm50.mdb within the Access 2002 designer and delete the following database links:


- annual_cost_factors


- distribution output


- feeder_output_by_cluster


- wirecenter_inv_per_line

2) Manually re-create the following hm50.mdb database links to the hmxldb.xls internal worksheets:

	Internal Worksheet Name
	Database Link Name

	annual cost factors
	annual_cost_factors

	distribution output
	distribution output

	feeder output by cluster
	feeder_output_by_cluster

	wirecenter output by CLLI
	wirecenter_inv_per_line


Please note that the database link and worksheet names don’t match in several cases.  Some have underscores between the words, or a different name entirely.  This is because the Visual Basic hcpmhm.vbp source code has hard-coded references to the above listed database link names, NOT to their corresponding worksheet names.  Apparently, this was done at the discretion of the programmer.
3)   Test the new database links in the Linked Table Manager utility.  If the links were created properly, you should not receive any errors.

4)   Save all changes and exit the Access 2002 designer.

C.  Upgrade the existing Visual Basic (VB) programs:

The HCPM and HAI 5.0 contain programs coded in Visual Basic.  The old HCPM/HAI contained old VB coding compiled with an old VB compiler.  The old compiled code is no longer recognized by the newer MS Office applications.  These VB programs needed to be upgraded and recompiled in order to read and write to the hcpm.mdb and hm50.mdb converted to Access 2002 formatted databases.  This was accomplished by adding a Reference to the new Microsoft DAO 3.6 Object Library.   Within the MS Visual Basic 6.0 designer, the new Object Library was added in each of the following VB project files:


- cluster.vbp


- hcpmhm.vbp


- launcher.vbp

The following steps were performed on each project file:


1)   Open the project .vbp file.


2)   Select the Project menu from the main toolbar.


3)   Select the References option.

4)   Under the Available References window, uncheck the Microsoft DAO 3.51 Object Library.

5)   Under the Available References window, check the Microsoft DAO 3.6 Object Library.


6)    Click OK to accept.


7)   Change the CONNECT property to Access 2000 in every data control object defined in the project.  (For now, this applied only to the hcpmhm project.)

8)   Under the File menu from the main toolbar, select Make 'project'.exe.  This will recompile the project and create a new .exe file.


9)    Save the project and exit Visual Basic.

10)   In Windows Explorer, copy the .exe file to the c:\HCPM folder.

D.  Upgrade the HAI 5.0 master.xls spreadsheet file:

The master.xls spreadsheet, called by the hcpmhm50 program, invokes a VB routine that opens and reads the converted hm50.mdb Access 2002 formatted database.  Therefore, a reference to the Microsoft DAO 3.6 Object Library was added here as well:

The following steps were performed:


1)   Within MS Excel 2002, open the c:\HCPM\MODULES\MASTER.XLS spreadsheet.

2)   Invoke the MS Visual Basic designer/editor by simultaneously pressing the ALT and F11 keys.


3)   Under the Tools menu from the main toolbar, select References.

4)   Under the Available References window, uncheck the Microsoft DAO 3.51 Object Library.

5)   Under the Available References window, check the Microsoft DAO 3.6 Object Library.

6)    Save the c:\HCPM\MODULES\MASTER.XLS spreadsheet and exit MS Excel.

E. Testing the Migration:

The following tests were performed to ensure that the Model could accommodate input changes without using Access 97, and that the migration and conversion changes had no effect on the Model computations:

1)  Change HCPM Inputs

      
Line counts were increased for a wire center for each of the categories: BUSLINES, RESLINES, SPECIAL, PUBLIC, and SLBUS.  The model was run.  The change caused an increase in cost and a decrease in the cost per line (the anticipated directions) in the wire center.  When line counts were changed back to the original values, and the model was rerun, the cost and cost per line changed back to the original values.

2)  Change HAI Inputs

a. A new HM Scenario was created with increased the Cost of Debt (component of the Cost of Capital).  The change caused an increase in the cost and cost per line (the anticipated directions).

b. A new HM Scenario was created with increased Interoffice Investment (within Switching Inputs).  The change caused an increase in the cost and cost per line (the anticipated directions).
April, 2009 

Migration of the HCPM/HAI 5.0 application modules to run successfully under the Windows XP/Microsoft Office 2003 environment. 
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